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User Types 

The following table describes the three types of Abstract Plus users:

	Users
	Description

	Abstractors
	Abstractors can add, edit, delete abstracts, and update password and personal security questions.  They cannot perform administrative functions, such as setting up Abstract Plus configurations, without administrator login.

	Administrators
	Administrators can perform all the functions of all users, but have additional rights in the system.  They can perform additional functions such as editing the display types and fields, or changing the user ID or password, or perform audits at individual sites, and set Application Preferences, such as security policies and security questions. 

An administrator password is required in order to perform administrative functions.  

	Auditor
	Auditors can perform all the functions of Abstractors, but have additional rights in the system.  They can perform additional functions such as select an audit, perform Casefinding, Reabstracting, Recoding, and run audit reports.
An auditor password is required in order to perform audit functions.  


User Support

For user support information, refer to the Registry Plus web site at: http://www.cdc.gov/cancer/registryplus/ap.htm.  CDC supports the state central registry and the state central registry supports Abstract Plus users.

System Requirements 

For user system requirements information, refer to the Registry Plus web site at: http://www.cdc.gov/cancer/registryplus/ap.htm.

Security Features

User Accounts
Normally, establishing new User IDs and passwords requires the Administrator's password.  However, when Abstract Plus is opened for the first time, you can create your own user account and create additional users.  Click Add and follow the instructions in the topic Defining a New User on Initial Login.  In addition, during the first login, of a user, they will be prompted to select a new password, which meets the security parameters instituted by their location’s rules.  They can also be required to change their passwords periodically and answer security questions to reset their password when forgotten.
Administrator's Password

Configuring Abstract Plus and setting up users are functions that require an Administrator's password.  A dummy Administrator's password is supplied off the shelf, but it is recommended that the Administrator's password be changed to restrict access to functions that could damage the data or configuration.  Select Administrator Login / Modify Password from the Administration menu to change the password.  Changing the password requires knowing the current Administrator's password.

Auditor's Password

Performing audit functions require an Auditor’s password.  A dummy Auditor’s password is supplied off the shelf, but it is recommended that the Auditor’s password be changed to restrict access to functions that could damage the data.  Select Auditor Login / Modify Password from the Auditor menu to change the password.  Changing the password requires knowing the current Auditor’s password.

Encryption

Normally access databases, are accessible through opening them with Microsoft Access or other applications.  For added security, all tables are password protected and encrypted using Microsoft Access functions.  Separate instructions can be requested for their access.
Install and Access Abstract Plus

The administrator of the system or someone who has administrative privileges installs Abstract Plus on each user’s machine.  The generic version of Abstract Plus is available for download from the URL http://www.cdc.gov/cancer/registryplus/.  Most users will need a customized version of the software set up to meet the requirements of a specific locale, usually a state or specific study.  Contact your state central cancer registry staff for the distribution of their customized install files and additional support.  

To install and access Abstract Plus: 

1. Locate the install files required and launch the set-up wizard by double clicking setup.exe.

Result:  The Abstract Plus Setup Wizard opens.
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2. Click Next to continue installation.

Result:  The Select Installation Folder window opens.
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3. Click Next to accept the default installation folder.

Result:  The Confirm Installation window opens.
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4. Click Next to confirm you would like to install Abstract Plus version 3.0.

Result:  The installation process begins.
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Result: When installation has completed, the Installation Complete window appears.
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5. Click Close.

Note: Additional prompts will appear for .NET framework files or any other required files needed, that will be downloaded from appropriate sites.  This requires a connection to the internet.  If you do not have a connection to the internet, the required files can be downloaded from our website.
6. Click on All Programs menu, select Registry Plus group, Abstract Plus, and then AbstractPlus 3.0.
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Chapter 1: The Basics

Learning Objectives

Upon the completion of this chapter, you will be able to:

· Log in to Abstract Plus.

· Create your own user ID and password.

· Log in using your own user ID and password.

· Log out and use the Backup Option.

· Navigate the Abstract Plus main menu.

Overview

The first step in using Abstract Plus is to log in to the system.  You will create a unique user ID and password of your own or your administrator will define your account.  Creating a user ID and password is a unique way to identify the user.  When logged in with your own user ID and password, you may automatically be recorded as the abstractor.  This information can be used as selection criteria for reports and exports, and can be used for general tracking purposes to associate abstractors with their specific abstracts.  When logging out of Abstract Plus after completing your work, the system prompts you to back up the abstract database.
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	The Abstract Plus administrator can add as many users as necessary.


Standard Abstract Plus Keyboard Shortcuts

	Function
	Keyboard Combination

	Menus
	

	File Menu
	Alt+ F

	Administration Menu
	Alt+ M

	Utilities Menu
	Alt+ U

	Reports Menu
	Alt+ R

	Options Menu
	Alt+ O

	Help Menu
	Alt+ H

	Menu Items
	

	New Abstract
	Ctrl+ N

	Open / Find Abstract
	Ctrl+ O

	Copy Abstract
	Ctrl+ I

	Close Abstract
	Alt+ C

	Save Abstract
	Ctrl+ S

	Print Current Abstract
	Ctrl+ P

	Print Range of Abstracts
	Ctrl+ R

	Exit Program
	Alt+ F4

	User Management
	Ctrl+ U

	Manage Display Types
	Ctrl+ D

	Mange Personal Security Questions
	Ctrl+ Q

	Help Contents
	Ctrl+ F1

	Right-Click Menu Functions
	

	Search Help / Field Context
	F1

	Edits Information
	F2

	Field Message
	F3

	Special Field Lookup
	F4

	CS or Age calculations
	F5

	Run EDITS on current Abstract
	F8

	Standard Right-Click Menu
	

	Undo text change
	Ctrl+ Z

	Cut selected text
	Ctrl+ X

	Copy selected text
	Ctrl+ C

	Paste text from clipboard
	Ctrl+ V

	Delete selected text
	Alt+ D

	Select All text in entry field
	Alt+ A

	Move to first Text Field
	Ctrl+ T

	Section Headings
	Alt+ S

	Display Types
	Alt+ T

	General
	

	Open a combobox listing
	Alt+ Down Arrow

	Place a carriage return in NAACCR Text fields
	Shift+ Enter


Abstract Plus Menu’s

The main Menubar contains File, Administration, Auditor, Utilities, Reports, Options, and Help menus; furthermore, it displays the current edit set in use.  These menus provide access to all possible functions within the program.  Some menu items require an additional password to access.  In addition, some options are also available as buttons in the toolbar as shown below.
[image: image8.png]=

File Administration  Auditor  Utiities Reports Options  Help |EQH SSE Cantial V11 State EXInGoming ABsiracts
(3 New #)0pen [ Close

ave (E)Print [[)Copy S EDITS | 5 DAS | 4 lmport | Export





File Menu
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	Use this menu option…
	Or Toolbar Button
	To…

	New Abstract
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	Create a new abstract.  

	Open/Find Abstract…
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	Find and display information for an existing abstract.  

	Copy Abstract…
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	Copy an existing abstract.  

	Close Abstract
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	Close an open abstract.  

	Save Abstract…
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	Save abstract information.  

	Export Abstracts…
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	Export abstract(s) from Abstract Plus into a NAACCR layout text file.  

	Import Abstract in NAACCR Format…
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	Import abstract(s) from a NAACCR layout text file into the Abstract Plus database.  

	Print Current Abstract
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	Preview the displayed abstract before printing it.

	Print Range of Abstracts…
	
	Select and send a range of abstracts to a printer or save in a file.

	Backup Abstract Database … 
	
	Backup the database to be used by Restore feature if database becomes corrupted.

	Restore…
	
	Restore the database.  Replace corrupted database with previously saved backup.

	Exit
	
	Log off Abstract Plus with an option to back up the database with your work.  


Utilities Menu
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	Use this menu option…
	Or Toolbar Button
	To…

	Batch Completion Re-check (Unexported Abstracts)
	
	Rerun EDITS and the completion count for unexported abstracts.

	Doctor Query System
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	Query and search the doctor database.  DQS can be accessed whether or not there is an active abstract or a physician field selected.  

	Manage Facility Codes…
	
	Import or edit Facility Codes located in the database.

	Manage Doctor Codes…
	
	Import or edit Doctor Codes located in the database.

	Delete Abstract(s)
	
	Delete selected Abstracts.

	Notepad
	
	Launch Notepad to view created text files.


Reports Menu
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	Use this menu option…
	To…

	Accession Register
	Preview the Accession Register abstract report before printing it.  

	Patient Index
	Preview the Patient Index abstract report before printing it.

	Selected Cases…
	Select specific cases and preview a report listing the abstract cases selected before printing it.

	Status Report (Count of Cases) Summary…
	Enter a date range and preview a report showing the totals of complete and incomplete abstract records before printing it.

	Completion Status of Abstracts by Month…
	Enter a date range and preview a report of the status of incomplete and complete abstracts within the specified date range before printing it.  

	Report Wizard
	Create new reports using abstract or audit databases.

	Run Custom Reports
	Run created reports.

	Report Generator Help
	Help files, demo, user manual, and training videos for Report Wizard assistance.


Options Menu
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	Use this menu option…
	To…

	
	

	Update Security Questions
	Update selected security questions and answers for current UserID.

	Change Password
	Change the password for current UserID.


Help Menu
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	Use this menu option…
	To…

	Contents
	View the contents of Abstract Plus Help.

	Search 
	Enter text for which you need more information.

	About
	View version information for Abstract Plus.


Defining a New User on Initial Login
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	You will create User accounts on the initial startup, if no users exist in the database.  Otherwise, the system disables this feature and starts at the login window.  Administrators can add as many users as necessary, at any time.
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	If users are predefined in database, go to First-Time User Login.


To create your own user account:

1. From the Start menu, select All Programs, then select Registry Plus Group, then select Abstract Plus.

2. Select AbstractPlus 3.0.

Result: The Create User window is displayed.
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3. Type user’s full name in the User Name field. 
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4. Type a UserID in the User ID field.
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5. Type user’s initials in the Initials field.

[image: image28.png]Selected User

User Name.

USER, NEWA

(5-35 characters) e.g. Smith, John A

UserID Initials

= E— B

(5- 10 Characters) e (@ Characters)

Jsmith cg.JAS





6. Click Add. 
Result: The system adds the new user ID to the users list.  Additional buttons appear that are options for the selected user ID.  Additional userID’s can be added by repeating steps 3 – 6.
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7. Click Close. 
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8. Continue to section First-Time User Login. 
First-Time User Login

To login as a first-time user:
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	If you just created your user account, go to step 3.


1. From the Start menu, select All Programs, then select Registry Plus Group, then select Abstract Plus.  
2. Select AbstractPlus 3.0.

Result: The Login window is displayed.
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3. Type your User ID in the User ID field.
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4. Type Welcome1 in the Password field.  
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	Asterisks will appear for added security.  Passwords are case sensitive.
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5. Click OK
Result: You will receive a message instructing you to define a password matching your facilities password policy.  
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6. Click OK
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7. Type in a password, which meets your locations password policy.  You must type your new password in both New Password and Confirm Password fields.
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8. Click OK
Result: You will receive the form below, requiring you to select security questions, which will be used in the future should you forget your password and need to reset without administrator intervention.  

9. Select a question for each combobox and type your answer in the textbox below the question.  
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10. Once all questions are selected and answers typed, click Submit Questions.
Result: The program will load and you may begin processing Abstracts.
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Note: Click Help, [image: image45.png]


 on the upper right-hand side of the window for detailed help information.

Normal Login Procedure 

After installing Abstract Plus, you can log in using your defined user ID and password.

To login to Abstract Plus:

1. From the Start menu, select All Programs, then select Registry Plus Group, then select Abstract Plus.

2. Select AbstractPlus 3.0.

Result:  The Login window is displayed.
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	If no users are defined, you will be prompted to create your own user ID.  (See Creating a New User ID section, for more detailed instructions.)  Otherwise, consult the Administrator to create your user ID, if it is not available.


[image: image47.png]



3. Type your User ID in the User ID field.

Note:  UserID and Password field have tooltips for requirements.
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4. Type your password in the Password field, asterisks will appear instead of the letters entered for security.  Passwords are case sensitive.
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5. Click OK
Result: The program will load and you can begin processing Abstracts.
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Logging Off / Exiting and Create Backup
When logging off / exiting Abstract Plus, the system prompts you to back up the current abstract data.

To log off / exit Abstract Plus:

1. From Abstract Plus menu, select File and choose Exit, press [Alt = F4], or press red X in upper right corner of screen. 

Result: A prompt appears, asking you if you want to back up your work. 
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	Although you can choose, it is strongly recommended that you back up all the work you have done during an Abstract Plus session.


2. Click Yes.  
Result: A dialog box appears.
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3. Select the location for saving the backup file by clicking Folder Search[image: image54.png]


.
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	You can navigate to an available path to save the backup file.


4. Next, select the desired compression level and type a password, if required.  [both optional]
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	Click Close to exit without saving backup.


5. Click Save
Result: The system saves the information in a zip file and displays a confirmation message.  A progress bar is also displayed at the bottom of the screen.

[image: image59.png]Abstract Plus Database Backup.

Selected File Path for Zi Files:
[CiRegPlusAbstractPlusIMDES Backup NEY

[Optionall To encrypt the zip file -
enter in Password below

O o C

O Minimum
® Maximum - slowest

Setthe compression level

Warning: Encrypted Zip File cannot be restored without
password. You must remember the password as it is not
stored anywhere. Support cannot restore your file.





6. Click OK to close Abstract Plus.
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Questions

1. Can you log into Abstract Plus without creating a user ID and password?  
2. Why is it important to create your own user ID and password?

3. Do you have to log into Abstract Plus to use the online Help?

4. When logging off Abstract Plus, how can you ensure that the work you did up to the current session is secure and safe.
Chapter 2: Working with Abstracts

Learning Objectives

Upon the completion of this chapter, you will be able to:

· Import abstracts into Abstract Plus.

· Identify the areas in the Abstract Plus abstracting screen.

· Create a new abstract.

· Modify an abstract.

· Copy an abstract.

· Correct errors in an abstract.
· Save an abstract.
· Export abstracts.

· Print a range of abstracts.
· Print current abstract.
· Use the Notepad Function (Utilities).

· Use the Help to find out more information about fields.

· Backup and restore abstracts.

· Run reports.
· Create new reports.

· Update / Reset password.
· Update security questions.

· Import / Update doctor and facility codes.

· Delete abstracts.
Overview

You can start working with abstracts by: 

· Importing abstracts in NAACCR format from any system in an ASCII text file.

· Creating a new abstract.

· Copying an existing abstract and saving it as a new one.
An existing abstract can be modified and the changes saved.  Abstracts can also be exported in NAACCR format in an ASCII text file, to any other system.

Importing Abstracts 
The Import function allows you to import NAACCR-format abstract records of Type C or A.  The import file may or may not contain Carriage Return, Line Feed characters after each abstract.  This function also performs a basic structural check for record size and version number before importing the abstracts.
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	We strongly recommend that you validate the data being imported for validity before performing the import using a data-editing program such as EDITS and its NAACCR metafile.


To import a file in NAACCR Format, click on Import Abstracts in NAACCR Format in the File menu or Import, [image: image62.png]4 Import




 on the toolbar, and then click Select File.  The system will provide a dialog box to select the import file name.  Locate the file to be imported, and then click Open.  The system will verify that the file contains valid NAACCR records and will display a record count and other information about the file.

You can assign a Completion Status of Complete or Incomplete to all of the abstracts in the import file.  By default, the status is Incomplete.  You can also select the option Use Incoming File’s Export Status, to use the Date Case Report Exported field to mark the case as previously exported.

Imported abstracts will have unique Abstract Reference IDs assigned and can be accessed with the Open/Find Abstract menu option.  The item Date Created will be set to the date the abstract was imported.

Purpose

· Import abstracts

· Use the online Help for further information and assistance.

· Open a selected abstract.

To import abstracts:

7. Click Import, [image: image63.png]4 Import




 on the toolbar or select Import Abstracts in NAACCR Format from File menu.

Result: The Import Abstracts in NAACCR Format window opens.
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8. Click Select File.

Result: The system displays a Windows Explorer dialog box where you can select a file.
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9. Navigate to C:\RegPlus\AbstractPlus\Imports\V11data.dat.  Abstract Plus comes pre-loaded with this file.

Result: The system populates the fields in the dialog box with the information in the selected file, such as the number of abstracts in the file and the NAACCR abstract type.  Notice the Import Log button on this window.  This button lets you view the history of the abstracts you have imported.
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10. Click [image: image67.png]


 to display the Help for the window and learn more about each field.

11. Click Import.

Result: The system imports the abstracts and displays a confirmation message at the bottom of the window.
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12. Click Import Log.

Result: The system displays information about the data that has been imported, the name of the abstractor, number of abstracts, and file name.
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7. Click Close to close the Import Log, and Close again to close the Import window.
Opening an Abstract

To open an abstract, click on Open/Find Abstract in the File menu, or click the Open Abstract [image: image70.png]8 Open




 on the toolbar.  This will bring up the query interface for searching the database.

8. Click Open, [image: image71.png]8 Open




 on the toolbar, Open/Find Abstract on File menu, or press [CTRL + O].

Result: The system displays the Search Abstract window with the Name field highlighted.
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9. Press Enter,[image: image73.png]Enter I



.

Result: The system displays all the available abstracts.  Notice that you can sort all the abstracts by simply clicking on any heading.  For example, you can sort the list by date diagnosed, or sex, or vital status (is patient dead or alive?), or abstract number, etc.
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10. Click Atarms, Sargent and click Select to display and view this abstract. 

Result: The system may display an Edit Set Results popup with the abstract screen, informing you that the abstract you are opening contains errors.  Running edits on open of an abstract, is an administrator option in the Display Type. 
	[image: image75.png]



	Notice that the Edit Set Results window displays on the right of your abstract, with the option to resize, minimize, move, or close it.
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11. Click Close on Edit Set Results popup.

Result: The selected abstract receives the focus in the abstracting window described in the next section.  
Abstracting Window
The abstracting window consists of two main areas: entry and text fields.  The Abstracting Window in Abstract Plus presents a single record (abstract) for data entry, data editing, viewing, or printing.  The window consists of two adjustable panels.  The left panel contains all (or a defined subset, called a Display Type) of the available data items for the abstract except text fields.  The right panel contains the text fields of the abstract, including diagnostic procedure, treatment text fields, and miscellaneous fields.

The current edit set is highlighted on the menu bar.  Above the abstracting fields are drop-down boxes from which the user can select an Abstract Section, or a Display Type, and an option for holding the abstract from exporting when complete.  The Abstract Sections navigates you to the fields grouped in a section name.  
The Display Type selected, sets customizations like the fields displayed, critical fields, and the edit set options.  In a selected abstracting field, data can be entered, selected from a drop-down list, calculated from a calculator button, or selected from a look-up button, as available for that field.  
Additional options for a field are available with a right click menu or function key, including copy/paste, Field Context Help (F1), EDITS information (F2), Field Message (F3), Field Look-up values (F4), CS or Age Calculation (F5), and Run EDITS on the current abstract (F8).

The table below lists the main areas in the abstracting screen.

	Abstracting Screen

	Entry Fields

(Left Panel)
	Text Fields

(Right Panel)

	· Abstract Sections

· Display Type

· Field Title

· Field Value

· Field Context Help

· Error notification

· Abstract Ref ID

· Field Message

· Held Status

· Look up and Calculate buttons
	· Field Title

· Field Value

· Field Context Help

· Error notification

· Space remaining indicator

· Field Message
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Creating a New Abstract 

To enter a new abstract, first select New Abstract from the File menu or click New [image: image78.png]New




 on the tool bar.  The abstracting screen will appear.  ‘Unsaved Abstract’ will appear in the top left corner of the entry form.  The number (AbsRefID) assigned to the new case will replace ‘Unsaved Abstract’ with ‘Abstract No.  #’ when the abstract is saved. 
If multiple Display Types have been defined, select one from the drop-down list above the abstracting fields.  Field titles for the selected Display Type will appear in the left panel.

Purpose

· Enter information for a new abstract.

· Use the online Help for further information and assistance.

To create an abstract:

13. Click New, [image: image79.png]New




on the toolbar, select New Abstract on File menu, or press [CTRL + N].
Result: The system displays an abstract with blank fields.  Notice that the abstract does not have an assigned number, and the Abstract Sections is selected with a blinking cursor.  This abstract will receive an abstract number the first time it is saved.
14. Select the display type APDefault2, and then select the Name--Last field.
15. Type Jones in Name--Last field.
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16. Press Enter,[image: image81.png]Enter I



.  Note you can also press Tab,[image: image82.png]


 to move to the next entry field.

Result:  Notice that Name--First field is now highlighted and you can enter data for that field. 
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17. Type Ellen in the Name--First field and press Enter,[image: image84.png]Enter I



.
Result: Notice that Middle Name field is now highlighted and ready to receive data.
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18. Click the DXState field.

Result: A list of states appears.
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19. Type ‘G’ for Georgia.  Notice that the system searches on the first letter displayed in the dropdown, and you can select from the list from there.  
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20. Press Enter, [image: image88.png]Enter I



.

Result: The next field is now highlighted with the field message displayed in a pop-up.
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21. In the Abstract Sections drop-down list, select DEMOGRAPHIC.

Result: All fields belonging to the Demographic section are displayed, and the first field in the group is selected for entry and the field message pop-up is visible, if selected field has a message.
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22. With the Birthplace field selected, type USA in the entry field, and press F8, to run EDITS.
Result: An error icon [image: image91.png]


 appears informing you that the value entered is not valid.  Notice also, the Edit Results popup is also displayed, if Show All Errors after EDITS re-check option is selected.
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Error messages along with  list of fields and values checked by the edit are listed
below each failed edit. Click on a field below any error message to move to it in the.
dataentry area and make corrections.

Edit Set Name: Central: Vs11 State Ex-Incoming Abstracts
Total Edit Errors for Abstract: 41

Edit Name: Addr at DX—City
Error: Addr at DX~City must contain letters and spaces only, left-ustified
Fields In Edit Addr at DX--City = <BLANK>





23. Click Close on Edit Set Results window. 
24. Right-click field to display menu, select Field Context Help.  You can also press [F1], while a field has focus.
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Result: The Help information for the specific field appears.
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25. Close the Help page and select the Birthplace field.
26. Press [F4] or [image: image96.png]


 to view the valid values for the Birthplace field.
27. Type United States in the Search field.
Result: The system highlights United States in the list even before you finish typing.
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28. Double-click the selection or arrow down to the grid and press Enter, [image: image98.png]Enter I



 to choose the highlighted item.
Result: The system populates the Birthplace field with 000, which is the code for United States, and selects the next field.
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29. Navigate to Physician Follow-Up field in the F-UP/RECURRENCE/DEATH section.
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30. Select entry field and press [F4] or press [image: image101.png]


 button next to the entry field for Physician Follow-Up.
Result: The system displays the Doctor Query window, so you can select a doctor.
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31. Type JO in the Name field and click Query.
Result: The system displays a list of doctors whose last names begin with “Jo.”
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32. Double-click on the row for doctor ID 20000002, James Jones.

Result: The Query pop-up window closes, the doctors’ ID appears in the field, and the system selects the next field. 
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Entering Information into Text Fields 

Text fields are used for entering additional information.  Text fields are listed on the right panel of the abstracting screen.  The text fields have an independent scrollbar separate from the one used by the entry fields on the left panel.  The divider in the center of the two sections can be adjusted to show more of one side or the other.  Each text field is stored independently in the database and the amount of text space in each defined area is predetermined, and the progress bar at the bottom of the textbox indicates the approximate space already used.  Use abbreviations to maximize space.  Use the text area Remarks or Local Text for text overflow.  

Purpose

· Enter text into various text fields.

· Use the online Help for further information and assistance.

To enter text in text fields:

1. Select Physical Exam text Field.

2. In the field, type the following text.  ABD DISTENDED.  DULL TO PERCUSSION.  MASS PALPATED IN UPPER ABD
Result: A progress bar under the Text area displays the percentage of space the text you just entered has used for that field.
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3. Use the Scrollbar, press tab,[image: image106.png]


 or  Enter,[image: image107.png]Enter I



 to navigate to Histology Title (Type, behavior, and Grade) and enter the following text.  PAPILLARY ADENCA GR2
Result: The progress bar under the Histology Title Text area displays the percentage of space used and remaining for that field.
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4. Locate the Chemotherapy Treatment field, and enter the following text.  12/17/96 THIOTEPA 8/16/97 CISPLAT, CTX
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5. In Remarks field, enter the following text.  PLACED ON SUPPRESSIVE TRX WITH SYNTHYROID TO SEE WHETHER THIS NODULE WOULD REGRESS
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Correcting Errors  
For an abstract, you can view the errors for an incorrect field entry, when you save the abstract, open an abstract, if administrator selected these options, or when you click EDITS, [image: image111.png]2 EDITS




 on the toolbar or press [F8].  The Edit Set Results window will display on the right half of the screen on open or save, and provided Show All Errors after EDITS re-check option is selected, when EDITS, [image: image112.png]2 EDITS




 or [F8] was selected.  This will provide all EDITS information and will contain a hot link to each field with an error.  When a link is clicked, it will take you to that field, to correct the error.

Each field with an error will display an error icon [image: image113.png]


 between the field label and entry field.  Placing the mouse over one of these icons will display a popup message with basic EDITS information.  You may choose to run NAACCR edits on the current abstract at any time.  Click the EDITS button on the tool bar or press [F8] to make sure all of the errors have been cleared.

When EDITS processes and all edits pass, the system sets the case to Complete and sets the Date Case Completed to the current date.  This date will not change unless the case becomes Incomplete, in which case the date will be reset to a blank.  This can happen if edits are rerun and errors are found because the data has been changed, or a different edit set is applied.  Once the errors are fixed, the case will again be set to Complete and the Date Case Completed will be set to the new current date.
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	The Edit Set Results window displays on the right of your abstract, with the option to resize, minimize, move, or close it.

	[image: image115.png]



	The Edit Set Results window will only display if Show All Errors after EDITS re-check is selected on the Options menu.  To display this information manually press [F2] or right-click on any field and select Edits Information from the right-click menu.


Purpose

· Displays edit errors in the abstract.

· Correct edit errors in the abstract.

To view and correct the errors in the abstract:

1. Click EDITS, [image: image116.png]2 EDITS




 on the toolbar or press [F8].
Result: An Edit Set Results window informs you that the abstract has errors.  Notice that the number of critical missing fields in the abstract is also displayed.  
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2. Click Close on Edit Set Results window and return to the abstract display. 
Result: Return to main abstracting screen and all fields with error have an error icon[image: image118.png]


.  
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3. Select Addr at DX--City, enter Atlanta into field, and press Enter,[image: image120.png]Enter I



.

Result: Atlanta now appears in the Addr at DX--City field and the next entry field is highlighted.
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4. Click EDITS, [image: image122.png]2 EDITS




 on the toolbar or press [F8].

Result: The corrected field no longer appears on the edit log, ordered by edit name, and the [image: image123.png]


 is not next to the field and the number of errors has decreased by one.
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Saving an Abstract 

The abstract can be saved at anytime, even with critical fields missing information or edits errors.  However, the system will not mark such abstracts as complete.  You can return later to correct the errors and complete the abstract.

Select Save Abstract from the File menu, click Save, [image: image126.png]


on the toolbar, or press [CTRL + S].  If the abstract has edit errors or contains missing critical fields, the abstract is considered Incomplete by the system.  The message Abstract Saved will appear at the bottom of the screen, when completed.  The first time the abstract is saved, the field Date Created will be set with the current date.

Purpose

· Save the abstract.

To save an abstract:

1. Click Save, [image: image127.png]


 on the toolbar, select Save Abstract from the File menu, or press [Ctrl + S].
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	The system displays the following message informing you that there are changes in the abstract, which have not been saved, if you select [image: image129.png]Close




 from the toolbar without first saving your changes.  You will receive a request message, asking if you want to save, discard, or return to the abstract (Cancel).
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Click Yes, Save to save the abstract Cancel to return to the abstract, or No, Discard to close the abstract without the changes.




2.   Click Close on Edit Set Results window.

Result: The abstract is selected.

3.   Click Close on the toolbar, select Close Abstract from the File menu, or press [Alt + C].
 Result: The abstract is closed and you return to the main window.

Modifying an Abstract 

You can make changes to an abstract in Abstract Plus by simply opening the abstract, updating field values, and saving the abstract.

Purpose

· Open a saved abstract.

· Modify the fields in the abstract.

· Save the abstract.

To modify an abstract:

1. Click Open, [image: image131.png]8 Open




 on toolbar, select Open/Find Abstract on File menu, or press [Ctrl + O].
Result: A Search Abstract window opens.
2. Type JO in Name field and click Query.

Result: Ellen Jones appears in the list of results.
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3. Click the row containing Jones, Ellen and click Select, press Enter,[image: image133.png]Enter I



 or double-click on the row.

Result: The system displays an Edits Set Results window, informing you that the abstract contains errors.
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4. Click Close on Edit Set Results window.

Result: The abstract is selected.
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5. Click the Name--First field and highlight the entry or press [Shift + Home [image: image136.png]Shift I
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], then press Delete,[image: image138.png]


.

Result: The system removes Ellen from the Current Value field.
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6. Type Helen.
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7. Select County at DX field.
Result: The system displays a popup containing the field’s message.
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8. Type COB into the selected Field, then press [F4] or click[image: image142.png]


.

Result: The system displays the grid lookup with Cobb County listed.
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9. Double-click the selected row or arrow down to the grid and press Enter, [image: image144.png]Enter I



 to select Cobb County and return to the abstract.

Result: The system displays the abstract with 067 populated in the County at DX field and selects the next field.
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10. Click Close.
Result: The system displays a message box asking if you want to save the abstract.
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11. Click Yes, Save.
Result: The system saves the abstract and returns to the main window.

Copying an Abstract 

When abstracting more than one primary tumor for a patient, you can enter values on one abstract and then copy it to start the subsequent abstract.  After opening an abstract, copy it by selecting Copy Abstract from the File menu, clicking Copy,[image: image147.png]Copy




 on the toolbar, or press [CTRL + I]. 

A new abstract with the next available abstract ID will appear with all the values from the copied abstract.  Modify any necessary fields in the new abstract.  If this is a new primary, be sure to enter all fields pertaining to the diagnosis and treatment of this particular primary.  Also, be sure to update the sequence number fields.

Once all modifications are made, save the abstract.
Purpose

· Open a saved abstract.

· Copy the abstract.

· Modify the abstract.

To copy an abstract:

1. Search for Sargent Atarms abstract and open it.
2. From File menu, select Copy Abstract or click Copy, [image: image148.png]Copy




 on toolbar, or press [CTRL + I].

Result: The system saves the current abstract, assigns a new number, and refreshes the abstracting screen with the new abstract.
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Result: The new abstract takes the place of the old abstract.
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3. Click Name--Last field, and highlight the entry or press [Shift + Home[image: image151.png]Shift I
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], then type Williams, and press Enter, [image: image153.png]Enter I



or Tab,[image: image154.png]


.
Result: The system removes Atarms and replaces it with Williams, and moves to the next field.
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4. Click Name--First field, if not already selected, and highlight the entry or press [Shift + Home [image: image156.png]Shift I
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], then enter Jack into field, and press Enter, [image: image158.png]Enter I



or Tab,[image: image159.png]


.
Result: The system removes Sargent and replaces it with Jack, and moves to the next field.
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5. Close and Save.

Exporting Abstracts 

The export utility exports abstracts stored in your local database, usually in NAACCR Type 'A' format.  These export files are text files (.txt) with Carriage Return, Line Feed characters inserted after each abstract to facilitate handling by other programs. 
Only abstracts that are considered Complete by the system, i.e., they have passed all edits and have no Critical Fields missing, will be exported, unless you choose the option to Export All Abstracts in Database.  Abstracts that have been flagged Held By Abstractor likewise will not be exported, unless you choose the option to Export All Abstracts in Database.

Export files can also be created for other purposes, such as for "snapshots" of the database for analysis, for special studies, or for quality control.  The export utility allows multiple additional Export Selection Options.  You may combine selection criteria in any number of ways for flexibility in selecting sets of abstracts.  Unexported abstracts are checked against the current sets of critical fields and edits before the process is allowed to proceed.  You may select or de-select any number of Export Selection Options by clicking on the options.  If the last selected option cannot be logically combined with certain previously selected options, the earlier options will be de-selected automatically. 

Delimited Export Files

The central registry may configure Abstract Plus to allow exports to be created in an alternative format of pipe-delimited files.  The default is not to allow this option.  See Setting Preferences for more information.  If the choice is allowed, you will be able to specify the items to be included in the export file, or Abstract Plus may have been pre-configured with a delimited file format.  See Export Selection Options for more details.

Export All Abstracts 

The central registry may configure Abstract Plus to restrict this choice to Administrators or personnel with Administrative level authority.  In this case, you will be asked for the Administrator's Password before the export file can be created.  See Setting Preferences for more information.  
To export abstracts, click on Export Abstracts in the File menu or the Export, [image: image161.png]Export




 in the tool bar.  The Export Abstracts window will be displayed.  You must specify selection criteria before exporting.  Once a selection is made, click Select button, and the system will display the number of abstracts contained in that selection in the bottom status panel.  You may verify the selected contents by clicking the Preview button.  Data from the selected records will be displayed for inspection.  Click OK to create the export file, or Cancel to abort the process.  You may skip the preview step and click on the Export button.  If you have de-selected Mark Exported Abstracts as Off-Loaded, you will be asked to confirm that you want to export the records without marking them.  If so, click OK to create the export file, or click Cancel to abort the export.

Purpose
· Export all abstracts.
· Enter parameters for exporting abstracts.

· Export selected abstracts.
To export all the abstracts in the database:

1. Click Export, [image: image162.png]Export




 on the toolbar or from File menu, select Export Abstracts….

Result: The Export Abstracts window opens.
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2. Select Export All Abstracts in Database check box.

Result: The system de-selects the Mark Exported Abstracts As Exported check box.  This ensures that the abstracts you are about to export are not flagged or marked as exported.
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3. Click Select.
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	The Export All Abstracts in Database function may only be available to administrators, if the application preference is turned on.  If so, you will receive the following login screen, which requires the administrator password to continue.
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Result: The system indicates the number of abstracts that meet the criteria at the bottom of the window.
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4. Click Preview. 

Result: The Export Selection Preview window appears
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Report of Export File for Transmit

Once an export file is created, an Export File for Transmit report is automatically generated, which will appear on the screen.  The report details include file name, date of file creation, UserID of the current user, and a list of the abstracts in the file.  To print the report, click on the Print icon.  To save the report to a file, click the Save icon.  You may choose to save the report as any of the report formats listed.  Specify a folder and file name, and click Save. 

5. Click Print. 
Result: A windows dialog box appears with a progress bar, followed by the Report Viewer window displaying a preview of the report.  This report can be printed or saved in many different formats from this window.
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6. Close Report Viewer window and click Export on Export Selection Preview window.
Result: The system displays a File Directory window requesting both directory and filename information.  The system will also display a warning message that the abstracts will not be marked as exported.
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7. Click OK

Name and Location of the Export File

The system will provide a dialog box for specifying the location and name of the export file.  Select a location (path), enter a file name, and click OK.  The central registry may or may not provide guidelines for assigning meaningful file names.  It is recommended that the export files be written to a location on the hard drive, preferably in a folder in the AbstractPlus\Export directory.  From there, the files can be copied to portable media or transmitted to the central registry according to whatever protocol and procedure the central registry has established.  The export files are text files, with a default extension of '.txt'.
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8. Type V113Export in File Name field and click Save.

Result: The system saves the abstracts into a text file and a report preview that you can print or save in various formats. 
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	You can click [image: image174.png]


 at the top left of the screen to open a dialog box and print the report.  You can click [image: image175.png]


 to save the report to various file formats.  
Several layout settings are available on the toolbar, to enhance the viewing of your report.
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9. Close the report preview to return to the Export Abstracts window.

Export Log
The Export Log provides the history of exports from your local database.  To access the Export Log, click on Export Abstracts in the File menu.  This will bring up the export window.  Now click on the Export Log and Show All Exports command buttons to review the history of all exports to date.  You may also search for specific exports by entering a date range and/or by searching for an abstract ID that may be found in any of the exports, with the Select command button.

In the export log window, you can click on any of the grid rows to review all abstract IDs associated with the selected export file and see details from each case in the export file.  You can click Print to reprint the selected export file report.

10. Click Export Log to view the log of exported abstracts.

Result: The Export Log window opens.  Notice that you can enter a date range or enter Select Case ID, and click Find to view exports that contain the specified values.
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11. Click Find All Exports to view all exports in log.
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12. Click Close to return to the Export Abstracts window and Close to return to the main menu.

Export Selected Abstracts
All export selection options except “Export All Abstracts in Database” will exclude incomplete abstracts from the selection set.  

The Export function provides the following selection options:

· Export All Abstracts in Database: This option selects all abstracts stored in the database.  Note that a preference may be set to require entry of the Administrator’s Password before this option will be performed. 

· Export only Un-Exported Abstracts To Date:  This option selects only those abstracts, which have never been marked as having been previously exported.

· Export by Date Created (Entered):  This option lets you select abstracts by the date that the abstracts were entered.  This date is in the system field Date Created in each abstract.

· Export by Date Previously Exported:  Abstracts that are marked as Exported also have the date of export recorded in the record in the system field Date Offloaded.  This option lets you select all abstracts that are marked with a certain export date or date range.  You may confirm an export date by looking it up in the Export Log Report.

· Export by DX Date:  This option lets you select abstracts by a range of the Date of Diagnosis.

· Export by Hospital:  This option lets you select abstracts by a hospital code in the field Reporting Hospital.

· Export by Abstractor:  This option lets you select abstracts by an Abstractor ID.

· Export by Project:  This option lets you select only those abstracts that are assigned to a certain Project ID.  If an abstract is assigned to other projects as well, it will still be selected.

· Export by Abstract ID:  This option lets you select specific abstract(s) by their Abstract Reference IDs (AbsRefID).

· Mark Exported Abstracts as Off-Loaded: When this option is, selected, all selected abstracts will be marked as having been exported on the current date.  This option is set to true (i.e., “Yes”) by default, and it is important that the default setting be retained for all routine exports of abstracts to be submitted to the central/state registry.  The user can de-select this option but should do so only for non-routine, unusual export conditions.  An example might include preparing an export file of selected abstracts to be imported onto another computer for internal use, or preparing an export file for statistical purposes.

To export only selected abstracts:

1. Click Export, [image: image179.png]Export




 on the toolbar or from File menu, select Export Abstracts….

Result: The Export Abstracts window opens.
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	The Export Only Un-Exported Abstracts To Date check box is selected.  This ensures that exported abstracts are not duplicated.


2. Select Export by Date Created [Entered] check box.
3. In From field select 10/01/2005, and in To field, select 10/30/2005.  [You can also enter in a date using the right arrow key to move between date elements.]  This ensures that only the abstracts created between the dates entered will be exported.  The Mark Exported Abstracts As Exported check box is selected.  This ensures the abstracts you are about to export are flagged as exported.
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	You can also select abstracts by the date previously exported, date diagnosed, date completed, hospital ID, project ID, abstractor ID, and abstract ID.
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4. Click Select.

Result: The system indicates that no abstracts meet the criteria, at the bottom of the window.

5. Close the Export Abstracts window.

Printing a Range of Abstracts

You can select one or more abstracts from your local database and print them.  You can even choose to print the abstracts to a text file instead of sending them directly to a printer.  The print utility can be used to select one or more abstracts from your local database for printing.  Select Print Range of Abstracts from the File menu or press [CTRL + R] to access the dialog.

The print utility allows several different options for abstract selection for printing.  You may also combine these selection criteria in any number of ways for flexibility in selecting sets of abstracts.  You may select or de-select any number of criteria options by clicking on them.  If the last selected option cannot be logically combined with certain previously selected options, the earlier options will be de-selected automatically.  You must have a selection of abstracts before printing.  Once a selection is made and the Select button is clicked, the system will display the number of abstracts contained in that selection in the bottom status panel.  Click Print to have the abstracts printed, or Close to cancel the print request.

All items and section headings in the current Display Type will be printed, in their order in the Display Type.  For coded items, a natural language label will also be printed.  If the “All Fields” Display Type is current, all items will be printed.

Abstract Selection Options

· Print only Un-Exported Abstracts To Date:  This option selects only those abstracts, which have never been exported before.

· Print by Date Previously Exported:  Abstracts are marked with a date at the time of export, if you choose to do so.  This option lets you select all abstracts that have been marked by a certain export date.  You may confirm the export date by looking it up in the Export Log report.

· Print by Date Created (Entered):  This option lets you select abstracts by the date that the abstracts were entered.

· Print by Hospital ID:  This option lets you select abstracts by a hospital code.

· Print by Abstractor:  This option lets you select abstracts by an Abstractor ID (User ID).

· Print by Project:  This option lets you select only those abstracts that are assigned to a certain Project ID.  If an abstract is assigned to multiple projects, it will still be selected.

· Print by Abstract ID:  This option lets you select a specific range of abstract IDs to print.

· Print All Abstracts in Database:  This option selects all abstracts stored in the database.

Purpose

· Enter the criteria for selecting abstracts.

· Print the abstracts to file.

To print a range of abstracts:

1. Click File menu, and select Print Range of Abstracts... or press [CTRL + R].
Result: The Print Abstracts window opens.

[image: image184.png]B print Abstracts

Abstract Selection [ Multple options may be selected |
Only Un-Exported Abstracts To Date:
[ By Date Previously Exported
Date Exported Range

From: [o1012000 ™

[J By Date Created [ Entered ]
Date Created Range:

From: [ow012000 | To: [03312000

Project [Select Only One]

Hospinl 1D
Here-

[
Abstractor D

Abstract 1D [Range]

Range example: 135812 (up.
1020 Characters)

[ Al Abstracts in Database





2. Select All Abstracts in Database checkbox.
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	You may select or de-select any number of criteria options by clicking on them if the All Abstracts in Database check box is not selected.  If the last selected option cannot be logically combined with certain previously selected options, the system automatically de-selects the earlier options.
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3. Click Select.
Result: The system displays the number of abstracts that meet the selected criteria at the bottom of the window.
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4. Click Print Preview.
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5. Click  [image: image189.png]


 to keep a copy of this report.  Then select[image: image190.png]TextFie.




 from the dropdown menu. 
Result: The system displays a dialog requesting what pages to export.  The printout will be export to a txt file.  You can also export your report to other formats, which include, but not limited to PDF, Excel, or Word.
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6. Select All and click OK.
Result: The system displays dialog requesting a name and location to store the text file.
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	If you wish to view the file immediately after export, check Open After Export.
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7. Enter Abstract Report and click Save.
8. Close the Report Preview.

9. Close the Criteria Selection window.
Printing the Current Abstract 
To print an abstract that is currently displayed, select Print Current Abstract from the File menu, click on the Print, [image: image194.png](£ Print




 on the toolbar, or press [CTRL + P].  The system will display a preview of the printed abstract on the screen.  Click the Print to print the current abstract to the selected default printer, or click the Save to create and save a soft copy of the printed abstract.  Close the window to exit the print preview without printing or creating a soft copy file.

All items and section headings in the current Display Type will be printed, in their order in the Display Type.  For coded items, a natural language label will also be printed.  If the "All Fields" Display Type is selected, all items will be printed.

To print the current abstract:

1. Click File menu, and select Print Current Abstract, click Print, [image: image195.png](£ Print




 on the toolbar, or press [CTRL + P].
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2. Click  [image: image197.png]


 to keep a copy of this report.  Then select Text File from the dropdown menu. 

Result: The system displays a dialog requesting what pages to export.  The printout will be export to a txt file.  You can also export your report to other formats, which include, but not limited to PDF, Excel, or Word.
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3. Select All and click OK.
Result: The system displays dialog requesting a name and location to store the text file.
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	If you wish to view the file immediately after export, check Open After Export.
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4. Enter Abstract Report and click Save.

5. Close the Report Preview.

Restoring Data   
The Restore function in Abstract Plus is extremely useful when something goes wrong with your data.  Rather than having to start from scratch, you can go back to a file that you saved with the same Abstract Plus version on a date when you encountered no problems.  This is one reason why it is recommended that you back up your work when shutting down the system.  The procedure described applies if the backup copy has been made using the Abstract Plus Backup function.  If using other backup procedures, follow their instructions for the restore function, or contact your computer support staff.

Select Restore… from the File menu.  Enter the path and file name of the backup file, or click Browse, [image: image201.png]


 to search for the directory and file.  Unless the default backup location has been changed, or unless other procedures have been set up locally, the backup file will be in C:\RegPlus\AbstractPlus\MDBS\Backup and will be named AbsPlus_Backup_Date_Time.zip.  [Substitute the date of the backup with the word Date.].  Click Restore.  The backup file will be unzipped (uncompressed) and written to the Absplus\MDBS directory as Absplus.mdb.  Click Close to exit without restoring.

If the backup file was made with an older version of the NAACCR record layout than the one currently represented in the Master.mdb file, the system may not be able to restore successfully.

Purpose

· Access a previously saved backup file.

· Replace the current data with the backup file.

To restore data:

1. From Abstract Plus menu, select File then select Restore…
Result: The Restore AbstractPlus Database window opens.
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2. Click [image: image203.png]


 to search for your back up file.

Result: A window that you can use to navigate to the backup file opens.
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	You can also type the path to the backup file that you want to use for the restore.  Backup files are named AbsPlus_Backup_Date_Time.zip.  [Substitute the date of the backup with the word Date.  Abs Plus_Backup_20090706_145523.zip.  This example states the backup was created on July 6, 2009 at 2:55:23 PM.]  


3. Navigate to and select AbsPlus_Backup_Date_Time.zip.  You saved this file the first time you logged off the system at the beginning of this training session.
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4. Click Open.

Result: The system closes the window and redisplays the Restore AbstractPlus Database window.  Notice that the path to the restore file now appears in the text box.
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5. Click Restore.

Result: A message and progress bar displays in the statusbar below to inform you of the progress and when complete

Questions

1. What are the three ways that you can use to start working with abstracts?

2. How is an ID assigned to an abstract?

3. Which feature allows you to view valid values for a field?

4. How do you know how much data a text field can take?
5. How do you know that an abstract contains errors?
6. Which tab do you use to correct errors in an abstract?
7. How do you know how many errors exist in an abstract?
8. Can you save an abstract that has errors?

9. Can an abstract exist without being attached to a project?

10. How can you locate a saved abstract?

11. Can you change the information contained in an existing abstract?

12. How can you create an abstract using the information from an old one?
13. How can you avoid exporting duplicate abstracts?

14. How can you see all the abstracts you exported?

15. How can you print multiple abstracts at the same time?

16. What is the main benefit of the Notepad integration feature?

17. How do you recover data in Abstract Plus if for any reason your data becomes corrupted?
Chapter 3: User Settings

Changing Password

This option is available from the Login screen and the Options menu.  You may also be prompted by the system to update your password periodically, if the application preference that requires password updates every so many days, was set by the administrator.
1. From Options Menu, select Change Password or when logging into Abstract Plus, click Change Password on the Login window after entering your UserID.
Result: Change user form will display with current UserID already entered.
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2. Enter your Current Password in Old Password field.
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3. Enter a New Password in New Password field, which meets defined requirements.  
Default password requirements: Password must be between 8 to 20 characters, contain at least one digit and one alphabetic character, and must not contain any special characters.
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4. Reenter New Password in Confirm Password field.
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5. Click OK to submit new password.

Results: Password is accepted or there is an error with the new password.  There are three possible errors when changing current password. 

Possible Errors when setting New Password
1. Old password is invalid.
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2. New and Confirm passwords do not match.
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3. New/Confirm password does not meet defined security rule.

[image: image213.png]. Your new passiord does not meet the rteri specfied. Please update your passiord.

Passiord must be betieen 8 to 20 characters, contain atleast one digit and one alphabetic character, and must not contain any special characters.





Using Forgot Password Function
This option is only available on the Login screen and requires user to answer predefined security questions.
1. Enter your UserID in UserID field, and then click Forgot Password.  
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2. Answer predefined Security Question(s).  The number of questions is determined by the application preference set by the administrator.  
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3. Enter your answer for each question in the field(s) provided.

4. Click Validate Questions once all questions are answered.

Result: If answer(s) are not equal to the first time login answers, you will receive an error message and you will be provided the opportunity to resubmit answer(s), up to three (3) tries.
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Result: If your answer(s) are correct, you will be permitted to choose a new password, which meets defined security rules.
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5. Enter a New Password in both New and Confirm fields, and then click Reset Password.  
Result: You are logged into Abstract Plus and your password is set to new value for the next login.

Updating Personal Security Questions

This option is available from the Options menu.  You are able to update your Security Questions and/or Answers anytime you are logged into Abstract Plus.  You might use this option when one of your questions is ‘How many children do you have?’ and you just had a new child enter your family.
1. From Options Menu, select Update Security Questions.
Result: Security Questions, which were previously answered during the first-time login, are displayed with the answers formatted with asterisks.
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2. You can either supply new answers to the previously selected questions; or select new questions and provide their answers.
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3. Once all questions and answers are updated, click Submit Questions to save the changes for future use.

Display Edit Set Results

To display the Edit Set Results window automatically, upon completion of EDITS, when abstract is opened, saved, or user requested EDITS processing; select [image: image220.png]. Show All Errors after EDITS r




 on Options Menu.  Otherwise, unselect this option[image: image221.png]Show All Errors after EDITS recheck




 and use F2 or Right-Click menu on a field to view results.  

To display this form at anytime an abstract is loaded, press either F2 or Right-Click on a field, and select[image: image222.png]Edits Information
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.  When results window is requested using F2 or Right-Click menu on a field, it will display only the Edit Set Results for that field.  You can access all Edit Set Results by clicking Show All.

Show All Edit Set Results [Note: Show All button is disabled.]
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Show only selected field’s results [Note: Show All button is enabled.]
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Chapter 4: Maintain Reference Tables
Facility Codes
Facility codes can be imported or maintained, using the Manage Facility Codes Menu on the Utilities Menu.  Abstract Plus off the shelf is supplied with a small file of dummy hospital and unknown hospital records.  Each state user can provide the program with a file containing information on the state’s hospitals.  The hospital CODES must be loaded into the HOSPCODES table in the Master database.
The data file may or may not contain Carriage Return Line Feed characters at the end of a record.  Data format is ASCII Text.  Standard codes for hospitals and non-hospital cancer reporting sources for the entire U.S. are assigned and distributed by the American College of Surgeons.  Most state users choose to load a subset of codes, for their own plus surrounding states.

Make sure to delete the dummy hospital records and to retain or reenter the records needed for handling unknown and non-specific hospitals (codes beginning with 9999).  

	Field Name
	Field Length
	Column Start
	Column Stop

	Value

*
	10
	1
	10

	(Empty)
	5
	11
	15

	Label

*
	40
	16
	55

	ContactName
	35
	56
	90

	Phone
	13
	91
	103


* Required fields

Import Facility Codes
1. From Utilities Menu, select Manage Facility Codes… and then select Import.
Result: Import Facility Codes window is displayed.
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	Replace All Facilities - if you need to replace all facilities within the database.

Append Facilities – if you need to add / update facilities within the database.


2. Select Append Facilities. 
3. Click Select File.

4. Navigate to C:\RegPlus\AbstractPlus\Imports\Hospcodes.txt.
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5. Click Open.
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6. Click Import.

Result: The Importing Record # field begins to increment until the end of file is reached.  When complete the status bar will indicate the import is complete.
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7. Click Close.
Edit Facility Codes
From Utilities Menu, select Manage Facility Codes…, then select Edit.

Result: Edit Facility Codes window is displayed and populated with all Facilities in the database.
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	Action
	How To

	Delete
	Select the row and press [image: image232.png]


.

	Edit
	Select the row or word(s) you want to change and enter new information.

	Add
	Click Add or scroll to last row and enter new information.

	Save
	Click Save


Doctor Codes

Doctor codes, can be imported or maintained, using the Manage Doctor Codes Menu on the Utilities Menu.  Abstract Plus off the shelf is supplied with a small file of dummy doctor and unknown doctor records.  Each state user can provide the program with a file containing information on the state’s physicians: their names, identifiers, and other items needed in the Doctor Query System.  The doctor information must be loaded into the DoctorQuery table in the Master database, used by Abstract Plus.  
There is a specified record format for importing data into Doctor Query System.  Data files for importing may or may not contain Carriage Return Line Feed characters at the end of a record.  Data format is ASCII Text.  Up to 32 million records can theoretically be imported.

Make sure to delete the dummy doctor records and to retain or reenter the records needed for handling unknown and non-specific doctors (codes beginning with 9999).

To import doctors, click on Utilities menu, select Manage Doctor Codes, then select, Import.  This will bring up the import interface for importing an external file that contains the doctor data in the specified format.  Click Select File to select the import file.  Click Import to begin the import.

	Field Name
	Field Length
	Column Start
	Column Stop

	DOCID
*
	8
	1
	8

	ADDRESS1
*
	35
	9
	43

	ADDRESS2
	35
	44
	78

	CITY

*
	20
	79
	98

	STATE
*
	2
	99
	100

	ZIPCODE
*
	10
	101
	110

	PHONE
	13
	111
	123

	LASTNAME
*
	20
	124
	143

	FIRSTNAME
*
	20
	144
	163

	ADDRESSNAME
	45
	164
	208

	SPECIALTY
*
	20
	209
	228

	PRACTICE
	20
	229
	248

	PATHLOC
	35
	249
	283

	SUPPRESSLET
	1
	284
	284


* Required fields--displayed on Doctor Query

Import Doctor Codes
To import Doctor Codes:
1. From Utilities Menu, select Manage Doctor Codes… and then select Import.

Result: Import Doctor Code’s window is displayed.

[image: image233.png]Warning:

In orderto assure data integrity, it is highly recommended that you check the import data forits
validity. DOCTOR IMPORT program will only assure the specified data types for individual felds in

the data being imported. Records with missing or incorrect data types will be omitted from the
import. See Help for details.

importie | (Esearie
—— ]

Ficansirectr. [N
© Repiace Al Docios © Agpend Dostrs





	[image: image234.png]



	Replace All Doctors - if you need to replace all doctors within the database.

Append Doctors – if you need to add / update doctors within the database.


2. Select Replace All Doctors. 

3. Click Select File.

4. Navigate to C:\RegPlus\AbstractPlus\Imports\Doctorquery.txt.
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5. Click Open.
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6. Click Import.

Result: The Importing Record # field begins to increment until the end of file is reached.  When complete the status bar will indicate the import is complete.
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7. Click Close.
Edit Doctor Codes
From Utilities Menu, select Manage Doctor Codes, then select Edit.

Result: Edit Doctor Codes window is displayed and populated with all doctor records in the database.
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	Action
	How To

	Delete
	Select the row and press [image: image240.png]


.

	Edit
	Select the row or word(s) you want to change and enter new information.

	Add
	Click Add or scroll to last row and enter new information.

	Save
	Click Save


Chapter 5: Additional Features

Using Notepad Function 

The Notepad program is integrated into Abstract Plus under the Utilities menu.  Notepad allows you to view the contents of a file using the Notepad program without having to navigate away from Abstract Plus.  This option is provided as a convenience to the user to permit you to look at and modify any external text files that might contribute to the work environment.  It is the same Notepad available from the Microsoft Accessories window.  To access Notepad, click on Notepad in the Utilities menu.
Purpose

· Access a previously saved text file containing abstracts.

· Open the text file using the Notepad function in Abstract Plus.

To view the abstracts in a text file:

1. Click Utilities menu and select Notepad.

Result: The Notepad program opens.
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2. Click File menu in Notepad and select Open.
Result: A windows dialog box opens.
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3. Navigate to the folder, that the system saved AbstractReport.txt, the file you created in the Print range practice activity.
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4. Click Open.
Result: The selected file opens in Notepad.
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5. View the contents of the file and close Notepad.
Deleting Abstract(s)

Abstracts can be deleted from the Utilities Menu.  This feature saves a copy of your Abstract Database, to the defined backup directory with a date timestamp within the zip file name, when you request to perform a delete.  For example, Absplus_Deletion_Date_Time.zip Abs Plus_Deletetion_20090706_145823.zip, which was created on July 6, 2009 at 2:58:23 PM.  If you have multiple records to delete, select all records prior to clicking the delete button.  This feature is useful for year-end archive, removal of duplicate records, or when the database becomes too large and old records are archived.
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	Since this function creates a backup of your database each time the Delete button is clicked; you will need to check you default database backup directory periodically to clean out extra backups.  


1. From Utilities Menu, select Deleted Abstract(s).  
Result: The Delete Abstract window is displayed.
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2. Enter your specific search criteria or just click Query to display all abstracts in database.
Result: The records matching the selected criteria are displayed in the grid and are available for deletion.
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	Function
	How To

	Delete Single Abstract
	Select the row containing the abstract you wish to delete and click Delete.

	Delete Multiple Abstracts
	To select multiple records for deletion, select the rows by click on the row and hold the CTRL key down.  Once all abstracts are highlighted, click Delete.


Result: After Delete is selected, the current Abstract Database is copied and compressed into a zip file within the database backup directory defined by your administrator in application preferences.  Then the records are removed from the current Abstract Database. 
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	If any records are removed by accident, the complete database can be restored using the Restore function on the File Menu.  
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	If any other changes were made after the deletion and you perform a restore, those changes will be lost.


Running Batch Completion Re-check

This feature permits you to process all unexported abstracts through EDITS.  This feature will either reset or update completion status for abstract processed.  When is a good time to use this process?  After receiving or creating, a new Edit Set and you need to re-check the abstracts using the new Edit Set.  

At any time you may check all unexported (also called unoffloaded) abstracts for completion status.  Click on Batch Completion Re-check (Unexported Abstracts) in the Utilities menu.  All abstracts not marked as exported will be rechecked against selected Critical Fields and edits.  The Completion Status of individual abstracts will be updated and altered if necessary.
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	Depending on the number of records to process, this feature can take a long time to run.  The larger the number of records the longer it will take.
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	The Edit Set is determined by your default Display.


1. From Utilities Menu, select Batch Competition Re-check (Unexported Abstracts) …  

Result: The following message appears confirming you want to continue.  Since this function can take a long time, depending on the number of unexported abstracts in your database.
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2. Click OK.
Result: If no Abstracts are marked as unexported, you will receive the following message.
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Result: If there are Abstracts to process, you will receive the following window.  This window contains the name of the Edit Set listed in the default Display Type.  In addition, all possible edit set names are listed to be used by EDITS.  The window also has a progress bar to provide feedback on how many abstracts are left to process.
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3. Select Central: Vs11 State Ex-Incoming Abstracts from the combobox
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4. Click Run.
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Result: After completion, of processed unexported abstracts through EDITS.  You will receive a message detailing the results.
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5. Click OK.
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